GRADUATE PROGRAM IN PUBLIC HEALTH

GUIDE TO COMPLETING THE
MASTER’S THESIS

Disclaimer This Guide to Completing the Master’s Thesis is meant as a resource for students in the Master of Public Health Program at the Icahn School of Medicine at Mount Sinai. The Program reserves the right to make amendments to the contents without notice. The content of this guide is not intended to be nor should it be regarded as a contract between the Program and any student or other person.
CONTENTS

CORE REQUIREMENTS PAGE 3

ADVISORS PAGE 4

MASTER’S THESIS PROPOSAL OUTLINE PAGE 5

MASTER’S THESIS PROPOSAL PAGE 6

MASTER’S THESIS PAGE 8

SUBMISSION SCHEDULE PAGE 11

DEPOSITING THE THESIS PAGE 12

GRADUATION APPLICATION FORM PAGE 14

OTHER REQUIREMENTS FOR CONFERRAL OF DEGREE PAGE 14

APPENDICES:

• APPENDIX 1: THESIS CHECKLIST PAGE 14
• APPENDIX 2: SAMPLE THESIS COVER PAGE PAGE 16
• APPENDIX 3: SAMPLE COPYRIGHT PAGE PAGE 17
• APPENDIX 4: SAMPLE APPROVAL PAGE PAGE 18
• APPENDIX 5: SAMPLE ABSTRACT FORM PAGE 19

Revised October 2014
CORE REQUIREMENTS
Students must register for the following to fulfill the Thesis requirement: *

RESEARCH METHODS MPH0320

Research Methods encompasses a set of fundamental skills and tools necessary for approaching the process of developing and answering a research question or being an informed consumer of information in the marketplace. This course provides a solid and practical framework enabling students to successfully embark upon their Master’s Theses. The course is an essential component to understanding how to organize research: helping students to conceptualize, develop, propose, design, and write research papers, in general, and the Thesis, in particular.

Students are required to take this course in their second term in the Master of Public Health Program. The course is only open to matriculating students in the Master of Public Health Program.
† Students who have taken MPH0702 Preparation for Global Health Field Work and in addition have prior research experience might be exempt from taking this requirement. Please contact the Track Advisor for details.

This 1-credit course will be graded on a Pass/Fail basis.

MASTER’S THESIS MPH0099

Students register for their Master’s Thesis on or before the Winter Term of their second year of study while researching and writing their Thesis. The Master’s Thesis must address a topic of relevance to Public Health.

4 credits

*Substitutions & Waivers Students are required to discuss any issues or questions regarding possible course substitutions or waivers with the Program Director.

Revised April 2014
SPECIALTY TRACK ADVISORS & MASTER’S THESIS ADVISORS

The Specialty Track Advisor serves as an important resource for students, providing information and advice on selecting elective courses, Practicum development, Master’s Thesis topic development, opportunities for research, as well as information on the Public Health profession. Please refer to the Student Handbook for a complete list of Specialty Track Advisors and their contact information.

Specialty Track Advisors can be a source of insight and suggestions for identification of a Master’s Thesis Advisor. In some cases the Specialty Track Advisor and the Master’s Thesis Advisor will be one and the same. Regardless of who performs the role of Master’s Thesis Advisor, students must obtain approval of their topic and plan from their Specialty Track Advisor or General Track Advisor prior to initiating research to ensure relevancy to Public Health.

The Master’s Thesis Advisor will be responsible for overseeing the development of the outline, proposal, finished write-up, intellectual dialogue, and the evaluation for a grade, of the Master’s Thesis. The Master’s Thesis Advisor works to help identify a Second Reader prior to completion of the Master’s Thesis. The Second Reader participates in the evaluation of the Master’s Thesis for a grade and the intellectual dialogue.

Students can also find faculty members with similar research interests who might be willing to function as Master’s Thesis Advisors by searching Icahn School of Medicine at Mount Sinai’s website. Suitable faculty for student advisement may be specialists in the student’s area of interest or have a command of pertinent literature and/or research.

Students are advised to begin to contemplate a topic for their thesis research early in their studies in the Program. This enables the student to maximize opportunities to interact with faculty most capable of assisting in the student’s intellectual growth. An open and consistent dialogue with the Specialty Track Advisor and/or Master’s Thesis Advisor can help students to pick topics and research questions that are more likely to be successful.

Once a student has identified a Master’s Thesis Advisor with whom he/she would like to work, the student asks the faculty member to complete the Statement of Support indicating his/her willingness to serve as a Master’s Thesis Advisor. Students and Master’s Thesis Advisors should discuss and reflect on, in addition to potential topics, those Public Health Competencies that should be covered during the Master’s Thesis experience. Advisors will be asked to note in the Master’s Thesis Evaluation Report which Competencies were covered. For a full discussion of Competencies please see the Student Handbook.

Students must submit the following in sequence to their Master’s Thesis Advisor for review, evaluation, and approval. Students should work with their Master’s Thesis Advisors to decide together how best to get the following information to them, whether through hard copy or email. In any case, students must deposit a final copy of the Master’s Thesis, approved by their Thesis Advisor and Second Reader, in hard copy along with a completed Master’s Thesis Deposit Form to the Program Office as well as Levy Library (see page 11). (For a complete Checklist see Appendix 1.)
1. **Master’s Thesis Proposal Outline** Students can use the Proposal Outline generated as the final exam for the MPH 0320 Research Methods course if this is the topic they intend to pursue for the final Master’s Thesis.

2. **Master’s Thesis Proposal**

3. **Submission of** final approved Thesis Proposal to the Thesis Advisor for their records

4. **Master’s Thesis**

5. **Deposit final hard copy of Master’s Thesis** to the Program Office

6. **Deposit Thesis with ISMMS Levy Library**

**MASTER’S THESIS PROPOSAL OUTLINE**

The Master’s Thesis Proposal Outline should be no more than two pages typed in a font no larger than 12 points and with margins of one inch on all four sides. Single spacing is acceptable. References are optional and not included in the two-page limit.

**COMPONENTS OF THE THESIS PROPOSAL OUTLINE**

1. **Identify the Research Question**

2. **Specific Aims & Hypothesis** This section explains the purpose of the Thesis and succinctly states the Thesis’ hypothesis.

3. **Background & Rationale** This section explains why the proposed topic is a question of public health significance.

4. **Study Design & Methods** This section describes the target population and how the research will be conducted.

5. **Timeline** This section indicates when each of the following will be achieved:
   a. Submission of completed Thesis Proposal
   b. IRB approval or documentation from the IRB that approval is not required
   c. Submission of the completed Thesis to Advisor
   d. Submission of Thesis to Program Office

Following submission of the Master’s Thesis Proposal Outline, the student will meet with his/her Master’s Thesis Advisor. The Outline will be reviewed and evaluated to determine, among other things, if the topic is suitable, the project feasible, and the research question is valid. The Master’s Thesis Advisor may consult with other faculty members in making this determination. The student will be notified when the Outline, or a subsequent resubmission, has been accepted. The student can then proceed to the next step of completing necessary research, data collection, etc.

Revised April 2014
MASTER’S THESIS PROPOSAL

Using the Master’s Thesis Proposal Outline as a starting point, the student writes his/her Thesis Proposal, elaborating on each of the sections of the Outline.

The student works with his/her Master’s Thesis Advisor to determine an achievable timeline; the due date for the Thesis Proposal is based on a timeline established upon the acceptance of the Outline. Students are strongly advised to plan ahead, keeping the deadline for completion of the entire Master’s Thesis in mind to ensure completion in time for graduation in the Spring of the following year. Master’s Thesis Proposals are to be submitted to the Master’s Thesis Advisor for review.

It is suggested that a student look to his/her Master’s Thesis Advisor for regular supervision. It is up to the student to schedule appointments with his/her Thesis Advisor to keep them informed and updated on the progress being made.

The student is reminded that faculty members need a reasonable period of time to review material. It is reasonable to expect that it may take one month for the student to receive written or verbal comments on work submitted to the Thesis Advisor. In some instances, it is entirely reasonable that the student be asked to meet with the Thesis Advisor and/or Specialty Track Advisor prior to a Thesis Proposal’s formal acceptance. Students are strongly advised to build these review times into the creation of their timelines and work closely with their Advisors to make sure they do not fall behind.

The length of the Master’s Thesis Proposal will vary with the topic covered; generally it will be between ten and twelve pages double-spaced in a font no larger than 12 points and with margins of one inch on all four sides. References are required and not included in the overall page length.
COMPONENTS OF THE MASTER’S THESIS PROPOSAL

1. **Describe the Research Question** Elaborate on what was presented in the Thesis Proposal Outline. (2 pages)

2. **Specific Aims & Hypothesis** This section explains the purpose of the Thesis and succinctly states the thesis’ hypothesis. (2 pages)

3. **Preliminary Background & Rationale** This section explains why the proposed topic is a question of public health significance. (4-5 pages)

4. **Preliminary Study Design & Methods** This section describes the target population and how the research will be conducted. (2-3 pages)

The student is reminded to keep the following in mind:

- If the thesis consists of epidemiological research, the proposal should contain a preliminary methods section including, but not limited to: the overall study design, target population, sampling methods, interventions (if any) to be carried out, outcomes to be measured, potential confounding variables to be measured or controlled for, operational definitions of variables to be measured, and preliminary data analysis plan. If the method of accruing study subjects is other than straightforward, contingency plans for responding to unexpectedly low recruitment rates should be included as well.
- If the thesis consists of other types of research, the proposal should contain a description of the methods to be used sufficient to enable a person with expertise in the area to evaluate the suitability of the proposed design and the feasibility of carrying out the research. The level of detail of this section should be analogous to that specified for epidemiological research above.

5. **Preliminary Timeline** indicating when each of the following will be achieved: (1 page)
   a. IRB approval or documentation from the IRB that approval is not required
   b. Submission of the completed Thesis to Advisor
   c. Submission of Thesis to Specialty Track Coordinator

The student will meet with his/her Master’s Thesis Advisor to review the Master’s Thesis Proposal. They will evaluate the proposal and discuss whether it is acceptable as is, acceptable with revisions, or unacceptable. The Thesis Advisor may consult with other colleagues in reaching this determination.
**Master’s Thesis**

Approved Thesis Proposals provide faculty with a sufficient sense of the student’s area of study to permit valuable advisement as the student progresses in his/her research. If a student submits drafts of his/her work, it is reasonable to expect that it may take one month for the student to receive written or verbal comments. Students are strongly advised to build these review times into the creation of their timelines.

The length of the Thesis will vary with the topic covered; generally it will be between twenty-five and thirty pages double-spaced in a font no larger than 12 points and with margins of one inch on all four sides. References are required and not included in the overall page length. Appendices are not included in the overall page length.

**Components of the Thesis**

1. Thesis Title Page (See Appendix 1)
2. Copyright Page (See Appendix 2)
3. Approval Page The approval page requires two signatures, those of the student’s thesis advisor and the Program Director (See Appendix 4).*
4. Acknowledgements
5. Abstract Limited to 150 words
6. Table of Contents
7. List of Illustrations, Charts, Diagrams, etc.
8. Describe the Research Question (2 pages)
9. Specific Aims & Hypothesis This section explains the purpose of the Thesis and succinctly states the thesis’ hypothesis. (2 pages)
10. Background & Rationale This section explains why the proposed topic is a question of public health significance. This section is for the student to write a critical review of the most pertinent published material that led the student to this thesis topic. (6-8 pages)
11. Study Design & Methods This section describes the target population and how the research was conducted. (2-3 pages)
12. Results Description of what was accomplished accompanied with relevant tables and figures. (3-5 pages)

* Instructions for attaching approval page:
  Step 1) Save the signed approval page as an image file (JPEG)
  Step 2) Upload to a blank page (page number iii) in your thesis word document
  Step 3) Save your thesis word document as a PDF

Revised October 2014
13. **Discussion** Evaluate results and explain their significance. The Results and Discussion sections may be combined. (6-8 pages)

14. **Conclusion** Summarize and state the significance of the research findings. (3-5 pages)

15. **Appendices**

16. **Bibliography**

**Formatting guidelines:**

**Margins:** Top, bottom, left and right margins must be 1 inch.

**Pagination:** Preliminary pages are numbered in lowercase Roman numerals. The title page is not numbered, but is counted in the preliminary pagination. The body of the text must be numbered consecutively in Arabic numbers beginning with the first page of the text and including illustrations, appendix, and bibliography. All pages except the title page must be numbered. Pages should be numbered in the center bottom of the page. For assistance on how to create two sets of differently numbered pages, please reference this [web page](#).

**Spacing:** The text and the abstract should be double-spaced. Each footnote, note, and bibliographical entry should be single spaced with double spacing between entries.

**Font:** The font must be uniform throughout the work. The font size should be 10 to 12 point. ETD Administrator requires you to embed all fonts. Embedding the fonts ensures that your manuscript’s formatting will translate clearly and consistently when it is converted to PDF. There are several ways to embed fonts:

**On a PC:**
To embed fonts in Microsoft Word 2003, create your manuscript using a TrueType font (NOT a scalable font). Some examples of TrueType fonts: Arial 10 pt., Garamond 12 pt., Tahoma 10 pt., Verdana 10 pt., and Times New Roman 12 pt. To embed the font, click on Options in the Tools menu. Then click the Save tab. Select the Embed TrueType fonts check box, and save your document. Once embedded in your Word document, the fonts will be embedded in the PDF when it is created.

To embed fonts in Microsoft Word 2007, create your manuscript using a TrueType font. Click on the circular Office button in the upper left corner of Microsoft Word. Click the Word Options button found in the bottom right hand corner. Choose Save from the left sidebar. Check the box next to Embed fonts in the file. Click OK and save your document. Once embedded in your Word document, the fonts will be embedded in the PDF when it is created.

Using Microsoft Word 2010, create your manuscript using a TrueType font. When you save the document as a PDF (File > Save as > Save as type: PDF), click the Options button in the Save as dialog window. Under PDF Options, check the box next to ISO 19005-1 Compliant.

Revised April 2014
On a Mac:
If you create your PDF using Word 2008 or 2011, fonts are automatically embedded in the document; you don’t have to do anything extra.

If you are not using Word 2008 or 2011, create your document and convert it to PDF using any available tool (ETD Administrator offers a PDF conversion tool if you do not have one). Then, open the PDF using the Preview function of OS X (e.g., ctrl-click the icon, and choose “Preview”). Select File > Save As… and choose PDF. This re-saves the document, this time embedding the fonts.

Footnotes: Footnotes should be single-spaced at the bottom of the appropriate page. If you prefer, notes may be arranged as notes at the end of each chapter; in that case, each note should be single-spaced, with double spacing between notes.

Illustrations, Charts, Photographs and Multimedia: You may include color illustrations, charts, graphs, tables, images, spreadsheets, computer code, and multimedia files. For tables, graphs, and images, you may include them in the document itself. For multimedia or related documents such as spreadsheets or databases, you will be given opportunity to upload them as supplemental files within the ETD Administrator. Do not embed media files in your PDF. If you use multimedia material covered under someone else’s copyright, you must provide written permission to UMI.

Previously Copyrighted Material: If articles, photographs, charts, tables, etc. for which you do not hold the copyright (including articles you’ve written for which you’ve signed away the copyright to the publisher) are included in the Master’s Thesis, permission must be obtained from the copyright holder for their use, and the written permission must be uploaded as a Supplementary File.

Citation Style: While not required, the manual recommended for style and methods of documentation is A Manual for Writers of Term Papers, Theses, and Dissertations, by Kate L. Turabian (Seventh Edition, Chicago, University of Chicago Press, 2007). We recommend that you consult with your advisors about what style guide they recommend. No matter which citation style you use, please be consistent.

SUBMITTING THE THESIS

You are responsible for submitting your Thesis to the MPH Program administration and the Icahn School of Medicine Levy Library.
MPH Program Submission Schedule

Students should submit their thesis to the Master’s Thesis Advisor and a copy to the Second Reader. The student and the Advisors should agree ahead of time what form submission will take: email or hard copy. Students are advised to submit their thesis to their Advisors by March 1st. The absolute final Master’s Thesis deposit date is May 1st. Please note: No extension of this deadline can be granted for June graduation.

The Thesis Advisor identifies a Second Reader. The responsibility for selecting a Second Reader rests with the Thesis Advisor and/or the Specialty Track Advisor; students should not be placed in the position of having to ask particular faculty members to fulfill the role of a Second Reader. (Second Readers who are not affiliated with the Icahn School of Medicine or Graduate School of Biomedical Sciences must be approved by the Program Director).

At the end of March or beginning of April, the student will meet with the Master’s Thesis Advisor and Second Reader to discuss the Thesis. This meeting is intended to be an intellectual dialogue in which the student should be prepared to discuss his or her work with respect to sources, findings, interpretations, and conclusions. The student is asked to begin with a five-minute oral summarization of the pertinent background and findings. The faculty members meeting with the student will take turns asking the student questions. At the end of the question period, a student is usually asked to leave the room and wait until asked to return. During the faculty discussion period, a decision is made on the Thesis. The three possible decisions are Pass, Incomplete, and Fail.

**Pass:** The Thesis is deemed acceptable subject to minor revisions. The student amends the Thesis in light of comments made by the faculty. Upon completion of the revisions, the Thesis Advisor and the Second Reader sign the Master’s Thesis Evaluation Report noting that all requested revisions have been made and that the student has passed the requirement.

Then, the student submits the revised Thesis and the Thesis Deposit Form to the Program Office. All revisions must be made and the Thesis deposited with the Program Office by May 1st if the student wishes to graduate in the month of June.*

**Incomplete:** The Thesis is deemed to be acceptable subject to major revisions. All revisions must be completed within three to four months but no later than one year from the date of the faculty meeting.

Upon satisfactory completion of the revisions, the Thesis Advisor notifies the Specialty Track Advisor and the student submits three hard copies: one to the Thesis Advisor, one to the Second Reader, and one to the Program Office. (NB: In some cases the Thesis Advisor may decide to call the student back for a second meeting and the process continues as outlined above.)

**Fail:** The Thesis is deemed to be unacceptable and the student is not recommended for the degree.

In addition to evaluating the written thesis, the Thesis Advisor and the Second Reader are asked to evaluate the five-minute oral summarization and intellectual dialogue and to note which Competencies were addressed during the Master’s Thesis experience as found in the Master’s Thesis Evaluation Form.

Revised April 2014
ISMMS Levy Library Submission Schedule

 Depositing Your Master’s Thesis:

To deposit your thesis, you will use UMI’s ETD Administrator:
2. Select Icahn School of Medicine from the list.
3. Create an account or log in using an existing account.
4. Once you create an account, ETD Administrator will walk you through the steps of accepting the UMI publishing agreement and uploading the relevant files and information about your submission. Your thesis must be submitted as a single PDF document. If you have not already converted it to PDF, you will be given the opportunity to convert your Microsoft Word file into PDF using the PDF conversion tool. All components of your manuscript should be in a single Microsoft Word file before you use this tool. You will also be able to submit supplementary files, such as multimedia documents.
5. You must include a copy of your signed Approval Page in your thesis (Appendix 4). *
6. If you so choose, UMI will handle copyright registration on your behalf with the Library of Congress. This is optional, but is strongly recommended.
7. If you choose to delay the release of your work, the print copy of your dissertation will also be delayed for the duration of the embargo period.
8. You are required to purchase a bound copy for the Levy Library’s collection, and you may also order additional bound copies for personal use.
9. Payment is remitted by credit card as part of the submission process.
10. After you complete your submission, Levy Library staff will review the submission before sending it to UMI. You may be asked via email to make formatting revisions. Submissions are only sent to UMI after the registrar has informed Levy Library staff that you are cleared.
11. You will be able to log in to ETD Administrator to check the status of your thesis submission and make revisions.
12. For answers to Frequently Asked Questions about ETD Administrator, please visit: http://www.etdadmin.com/cgi-bin/main/faq?siteId=224#submit. The FAQs provide useful information about the submission and revision process and technical requirements. You may also contact UMI directly at etdsupport@proquest.com.

* Instructions for attaching approval page:
Step 1) Save the signed approval page as an image file (JPEG)
Step 2) Upload to a blank page (page number iii) in your thesis word document
Step 3) Save your thesis word document as a PDF

Revised October 2014
Fees:

<table>
<thead>
<tr>
<th>Publishing Fee: choose one</th>
<th>Required (choose one)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Traditional Publishing</td>
<td>$0</td>
</tr>
<tr>
<td>Open Access Publishing</td>
<td>$95</td>
</tr>
<tr>
<td>Copyright Fee</td>
<td>$55</td>
</tr>
<tr>
<td>Optional / recommended</td>
<td></td>
</tr>
<tr>
<td>Levy Library Copy</td>
<td>$43</td>
</tr>
<tr>
<td>Required</td>
<td></td>
</tr>
<tr>
<td>Personal Copies</td>
<td>Varies</td>
</tr>
<tr>
<td>Optional</td>
<td></td>
</tr>
</tbody>
</table>

Fees must be paid by credit card as part of the submission process. Fees are subject to change.

Deadlines:

While the Master’s Thesis may be deposited at any time during the year, please review the chart below for deposit deadlines and enrollment requirements:

<table>
<thead>
<tr>
<th>For the degree to be awarded:</th>
<th>You must deposit by:</th>
</tr>
</thead>
<tbody>
<tr>
<td>September 30</td>
<td>September 15</td>
</tr>
<tr>
<td>January 31</td>
<td>January 15</td>
</tr>
<tr>
<td>June (ISMMS Commencement Ceremony in May)</td>
<td>May 1</td>
</tr>
</tbody>
</table>

If students should miss the deposit date and continue to finish their thesis in the next term, students must either register for a credit-bearing course, or pay the maintenance of matriculation fee. The master’s degree requirements are considered met after the student's record is cleared by the Graduate School, all fees owed to the Icahn School of Medicine and the Mount Sinai Real Estate Department are paid, and on the date the Master’s Thesis is deposited. Students that are delinquent in their accounts with any division of the School or Real Estate office will not be approved for deposit of the Master’s Thesis.

DEPOSITING THE THESIS WITH THE MASTER OF PUBLIC HEALTH PROGRAM

Once the Master’s Thesis Advisor has certified that the student has submitted a Thesis worthy of the Master of Public Health Degree, the student must, in order to receive his/her degree, deposit a final and clean copy of the Thesis with the Master of Public Health Program. The completed Master’s Thesis Deposit Form must accompany all deposits.

Final deposit must occur no later than 5 PM on or before May 1st for the student to participate in graduation ceremonies held in the month of May.

Revised April 2014
GRADUATION APPLICATION FORM

Students intending to graduate in May must submit a Graduation Application Form no later than February 1st of the year in which they intend to graduate. Please fill out the Graduation Application Form.

OTHER REQUIREMENTS FOR CONFERRAL OF DEGREE

The Master of Public Health Degree cannot be awarded until all of the student’s outstanding accounts have been cleared. These include the Library, Real Estate Office (for students living in Icahn School of Medicine housing), Student Health Services, the Financial Aid Office, and the Registrar’s Office. Please fill out the Student Exit Form.

Upon satisfactorily completing the above-mentioned requirements and payment of all outstanding fees, the degree is awarded on the conferral date following the final Thesis deposit. At the time of Thesis deposit, the student will receive a letter from the Director certifying completion of all academic requirements for the Master of Public Health Degree.

APPENDIX 1: THESIS CHECKLIST

The following checklist is to help students monitor their progress.

- 1. Enroll in MPH 0320 Research Methods course in the Spring II term of the first year.

- 2. Identify Master’s Thesis topic and Thesis Advisor in collaboration with Specialty Track Advisor.


- 6. Write and submit the Master’s Thesis Proposal.

- 7. Meet with Master’s Thesis Advisor to review Proposal.

- 8. Submit final copy of Proposal to Specialty Track Advisor.

- 9. According to the agreed timeline, the student will notify his/her Thesis Advisor and the Specialty Track Coordinator (if applicable) of the achievement of specific milestones and overall progress. If the student falls behind the established timeline, he/she submits an amended timeline.

- 10. Submit completed Master’s Thesis to Thesis Advisor. When no further changes are required by Advisor or Second Reader, the Thesis is formally accepted.
11. Meet with Thesis Advisor and Second Reader to have intellectual dialogue and receive grade. Completed Master’s Thesis Evaluation Form returned to Program Administration.

12. Subsequent to all requirements, students must submit a final Thesis version (in hard copy) and the Master’s Thesis Deposit Form to Program Administration no later than May 1st if the student wishes to graduate in June.

13. Deposit Thesis with the ISMMS Levy Library. Please include the sample approval page in your deposit. This requires the thesis advisor and program director’s signature (See Appendix for a copy of this approval page). The Levy Library uses an online thesis submission process, using Proquest’s UMI ETD Administrator. This tool allows you to upload your thesis as a PDF document and pay all fees by credit card. The fees are detailed in the ETD Administrator. They include a $95 publishing fee, and optional $55 copyright registration fee, the $43 purchase of a bound copy for the library, and the cost of additional bound copies (cost varies due to binding and number ordered).
Sample Approval Page

This manuscript has been read and accepted by the Graduate Faculty of the Mount Sinai Graduate School of Biomedical Sciences, in satisfaction of the thesis requirement for the Master of Public Health degree.

[signature] ______________________________ [Typed Name] Date
Thesis Advisor – [Typed Name]

[signature] ______________________________ [Typed Name] Date
Director, Graduate Program in Public Health – [Typed Name]

Icahn School of Medicine at Mount Sinai
Sample of Abstract Form

Abstract

[title]

by

[Author Name]

Advisor: [thesis advisor name]

[Text of Abstract double-spaced; should not exceed 150 words]